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LỜI MỞ ĐẦU

 Không biết tạo báo cáo nhanh, chuẩn, đúng ý sếp

 Giải quyết công việc quá lâu với các công việc lặp đi lặp lại

 Số liệu lộn xộn nên không thể thống kê

 Bảng tính nặng nề vì quá nhiều công thức

 Số liệu không thể liên kết giữa các bộ phận, phòng ban….

 Chưa hiểu rõ bản chất hàm nên không hiểu tại sao kết quả sai

 Không biết khi nào thì dùng hàm nào vào công việc đang gặp phải

Thành thạo Excel để quản lý giấy tờ sổ sách thu chi, quản lý bán hàng kinh doanh, quản lý 
nhân sự, tiền lương, quản lý kho hàng, hàng hóa, quản lý tài chính, phân tích dòng tiền, thẩm 
định giá, lãi vay, các hoạt động của cơ quan doanh nghiệp tổ chức hay công việc cá nhân đều 
được dùng bằng excel

Hãy đến với Tin Học Sao Việt, các vấn đề nan giải trên sẽ được giải quyết một cách bài bản, 
nhanh chóng và chuyên nghiệp, để bạn trở thành nhân viên xuất sắc, một chuyên gia trong
lĩnh vực thống kê, báo cáo và phân tích.
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LỜI MỞ ĐẦU

Trung tâm Tin Học Sao Việt tự hào là đơn vị hơn 10 năm kinh nghiệm trong lĩnh vực đào

Thống kê, Báo cáo và phân tích số liệu. Chúng tôi đã đào tạo cho hàng trăm Doanh nghiệp, cho

hàng ngàn học viên là người đi làm, đồng thời chúng tôi đã cung cấp dịch vụ viết phần mềm, 

file Excel theo yêu cầu với hàng trăm đơn hàng từ các loại hình Doanh nghiệp khác nhau… 

qua đó chúng tôi hiểu rất rõ tầm quan trọng và lợi ích mà bảng tính Excel mang lại.

Trong quá trình biên soạn, không thể tránh được một số thiếu sót, vì vậy sự đóng góp ý kiến

của Quý học viên cho Trung Tâm sẽ làm cho nội dung tái bản lần sau được hoàn thiện hơn.

Chân thành cảm ơn Quý học viên
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CHƯƠNG TRÌNH ĐÀO TẠO BẢNG TÍNH EXCEL CƠ BẢN 2

TIN HỌC SAO VIỆT
Chuyên nghiệp – Tận tâm – Học thành nghề

Bài 01

Thành phần và Giao Diện Bảng Tính

9 Cơ Sở Đào tạo
Hồ Chí Minh, Bình Dương, Đồng Nai

Bài 02

Các Thao Tác Cơ Bản Với Bảng Tính

Hotline/Zalo
093.11.44.858

Youtube/Tiktok

Tin Học Sao Việt

Website
blogdaytinhoc.com

Bài 03

Kiểu Dữ Liệu Trong Excel

Bài 04

Kỹ Thuật Trình Bảng Tính

Bài 06

Lọc Và Sắp Xếp Dữ Liệu

Bài 07

Tìm Kiếm Và Thay Thế

Bài 08

Tính Toán Và Công Thức

Bài 09

Một Số Kiến Thức Cơ bản về Hàm

Bài 10

Ôn tập Phần I

Bài 05

Kỹ Năng In Ấn Trong Excel



CHƯƠNG TRÌNH ĐÀO TẠO EXCEL THỰC HÀNH

TIN HỌC SAO VIỆT
Chuyên nghiệp – Tận tâm – Học thành nghề

Bài 11
Hàm Tính Tổng Và Hàm Đếm

9 Cơ Sở Đào tạo
Hồ Chí Minh, Bình Dương, Đồng Nai

Bài 12
Hàm Tìm Giá Trị Nhỏ Nhất, Lớn Nhất 

Và Hàm Tính Giá Trị Trung Bình

Hotline/Zalo
093.11.44.858

Youtube

Tin Học Sao Việt

Website
blogdaytinhoc.com

Bài 13

Hàm tính Tổng phụ SUBTOTAL

Bài 14

Hàm Xử Lý Thời Gian

Bài 16

Hàm Xử Lý Số

Bài 17
Hàm Kiểm Tra Thông Tin Và 

Hàm Xử Lý Số Lỗi

Bài 18

Hàm Tìm Kiếm (Dò Tìm)

Bài 19

Phép Kiểm Tra Và Hàm Điều Kiện

Bài 20

Bài Thi Tổng Kết Cuối Khóa

Bài 15

Hàm Xử Lý Chuỗi



KHỞI ĐỘNG CHƯƠNG TRÌNH

❑ C1: Nhấn tổ hợp phím Windows + S hoặc phím Windows → Gõ “Excel”

❑ C2: Nhấn tổ hợp phím WINDOWS + R → Gõ từ “Excel” vào mục Open.

❑ C3: Tạo mới từ chương trình hiện tại hiện tại: Nhấn tổ hợp phím Ctrl+N
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BÀI 1. THÀNH PHẦN VÀ TÙY CHỈNH GIAO DIỆN EXCEL
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BÀI 1. THÀNH PHẦN VÀ TÙY CHỈNH GIAO DIỆN EXCEL
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BÀI 1. THÀNH PHẦN VÀ TÙY CHỈNH GIAO DIỆN EXCEL

1. Menu

2. Tab (thẻ)

3. Ribbon (thanh công cụ)

4. Group Ribbon (Nhóm công cụ)

5. Ribbon (Công cụ)

6. Name Box (Địa chỉ ô)

7. Formula Bar (Thanh công thức)

I. CÁC THÀNH PHẦN CƠ BẢN TRÊN BẢNG TÍNH EXCEL
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Chọn File → Options → và thực hiện một số cài đặt sau:

❖ Thay đổi Font chữ mặc định của Excel

Chọn Gernaral→ chọn mục “When Creating new Workbooks”

❖ Thay đổi tính toán tự động trong Excel

Formulas → chọn mục “Calculation options”

❖ Thay đổi thời gian lưu tự động của Excel

Save→ chọn mục “Save workbooks”

❖ Tạo Tab, Group mới để quản lý các công cụ thường dùng

Customize Ribbon → New Tab =Tạo thẻ mới, New Group= tạo nhóm mới

❖ Ẩn, hiển thị Sheet, thanh cuộn

Addvanced→ chọn mục thay đổi tại “Display options for this Workbook:” và

“Display options for this SHEET:”

II. MỘT SỐ THAO TÙY CHỌN CÀI ĐẶT TRÊN BẢNG TÍNH EXCEL

BÀI 1. THÀNH PHẦN VÀ TÙY CHỈNH GIAO DIỆN EXCEL (tiếp)
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❑Ẩn/ hiển thị cửa sổ Menu, Tab(thẻ): nhìn sang góc phải trên cùng, gần

dấu - , có mũi tên hướng lên trên→ bấm chọn vào đó, có các mục sau:

II. MỘT SỐ THAO TÙY CHỌN CÀI ĐẶT TRÊN BẢNG TÍNH EXCEL(tiếp)

BÀI 01. THÀNH PHẦN VÀ TÙY CHỈNH GIAO DIỆN EXCEL (tiếp)
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BÀI 02. CÁC ĐỐI TƯỢNG VÀ THAO TÁC CƠ BẢN (tiếp)

I. WORKBOOK (ký hiệu là WB)

Mỗi một file Excel được gọi là một WB, tên của File là tên WB

❖ Tạo mới 1 WB:

❑ C1: Nhấn Windows + S hoặc Windows→ Gõ “Excel” → Enter

❑ C2: Nhấn tổ hợp phím WINDOWS + R→ Gõ từ “Excel” vào mục Open.

❑ C3: Tạo mới từ WB hiện tại: Nhấn tổ hợp phím Ctrl+N

❖ Lưu 1 WB mới tạo ra:

Chọn Ctrl+S→ chọn nơi lưu dữ liệu, và đặt tên tại mục FileName → bấm chọn Save. Từ lần

sau, chỉ cần nhấn Ctrl+S là File tự động lưu.

❖ Sao chép (nhân bản) 1 WB :

❑ C1: Mở thư mục có File cần nhân bản→ Chọn WB cần nhân bản → nhấn Ctrl + C→ bấm

chọn chuột trái ra ngoài→ nhấn Ctrl + V

❑ C2: Tại WB đang mở, chọn File→ Save as→ “Lưu 1 WB mới tạo ra”

❖ Đóng 1 WB :

▪ Nhấn Close(X) góc phải trên cùng màn hình Excel hoặc nhấn tổ hợp Ctrl+W
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BÀI 02. CÁC ĐỐI TƯỢNG VÀ THAO TÁC CƠ BẢN (tiếp)

II. SHEET (ký hiệu SH)

Mỗi một WB có nhiều SH, nếu coi WB là 1 cuốn sổ, thì SH như những tờ giấy trong cuốn

sổ đó, một SH là một tờ.

❖ Thêm: Chọn vào dấu + dưới khu vực tên SH

❖ Đặt tên: 

❑ C1: Chuột phải vào tên→ Rename

❑ C2: Nháy đúp vào tên SH

❖ Xóa: Chuột phải vào tên→ Delete

❖ Sao chép (nhân bản): Giữ chuột trái vào tên đồng thời giữ CTRL và kéo thả.
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BÀI 02. CÁC ĐỐI TƯỢNG VÀ THAO TÁC CƠ BẢN (tiếp)

II. SHEET (ký hiệu SH)

❖ Ẩn (hiển thị): Chuột phải vào tên→ Hide (Unhide)

❖ Di chuyển: Giữ chuột trái vào tên Sheet đồng thời kéo thả

❖ Sao chép hoặc di chuyển qua WB khác:

❑ B1: Chuột phải vào tên SH→Move or Copy→ tích vào “Creat a copy”

❑ B2: Tại mục “To Book”, chọn tên WB di chuyển tới→ OK
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BÀI 02. CÁC ĐỐI TƯỢNG VÀ THAO TÁC CƠ BẢN (tiếp)

II. SHEET (tiếp)

❖ Sao chép hoặc di chuyển qua Workbook khác: 

Xem tiếp trang sau
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BÀI 02. CÁC ĐỐI TƯỢNG VÀ THAO TÁC CƠ BẢN (tiếp)

III. DÒNG, CỘT

Cột (Column) thường ký hiệu bằng chữ cái, Dòng (Row) thường ký hiệu bằng con số.

❖ Chọn cột hoặc dòng

❑ Chọn trỏ chuột vào ngay giữa chữ cái hoặc con số

❖ Chọn nhiều cột, dòng: 

❑ Chọn liên tục: Chọn 1 cột→ giữ Shift đồng thời chọn cột khác

❑ Chọn không liên tục: Chọn 1 cột→ giữ Ctrl đồng thời chọn cột khác

❖ Xóa: Chọn cột hoặc dòng→ Chuột phải→ Delete (hoặc Ctrl + “dấu -” )

❖ Chèn: Chọn cột, dòng→ Chuột phải→ Insert (hoặc Ctrl + “dấu +” )

❖ Sao chép: Chọn dòng/cột→ Chuột phải→ Copy (hoặc Ctrl+C) 

❖ Di chuyển: Chọn dòng/cột→ Chuột phải→ Cut (hoặc Ctrl+X)
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BÀI 02. CÁC ĐỐI TƯỢNG VÀ THAO TÁC CƠ BẢN (tiếp)

III. DÒNG, CỘT (Tiếp theo)

❖ Dán: 

❑ C1: Ctrl+V để dán đè và thay thế cột khác

❑ C2: Chuột phải→ Insert Copied Cells (hoặc Insert Cut Cells), cách này không thay

đổi cột khác mà tự chèn them cột và dán vào.

❖ Ẩn/Hiển thị(Hide/Unhide): Chọn cột/dòng→ Chuột phải→ Hide/Unhide

❖ Giãn dòng, cột: Chọn trỏ chuột vào đường chỉ dưới dòng hoặc bên phải cột.

❖ Cố định Dòng/Cột/Vùng: View → Freeze panes → Freeze panes

❑ Cố định dòng: Chọn dòng dưới dòng cần cố định trước khi thực hiện như trên

❑ Cố định cột: Chọn cột bên phải cột cần cố định trước khi thực hiện như trên

❑ Cố định cả dòng và cột: Chọn vào 1 ô dưới dòng cần cố định và bên phải cột cần cố 

định trước khi thực hiện như trên

❑ Cố định vùng xem: Chọn dòng ngăn cách vùng → View → Split
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BÀI 02. CÁC ĐỐI TƯỢNG VÀ THAO TÁC CƠ BẢN (tiếp)

IV.ĐỊA CHỈ Ô

Địa chỉ ô là tên gọi của dòng và cột tương ứng, ví dụ B12=  địa chỉ Ô nằm trên cột B và

dòng 12

❖ Chọn: Chọn trỏ chuột vào ô bất kỳ

❖ Chọn nhiều ô: Chọn 1 ô đầu tiên→ giữ Shift và chọn vào ô cuối trong vùng

❖ Xóa: Chọn 1 trong các cách sau:

❑ C1: Chọn Ô→ phím Delete

❑ C2: Chuột phải→ ClearContents

❑ C3: Thẻ Home→ Nhóm Editing→ Chọn công cụ Clear→ chọn các mục sau:

✓ Clear all: Xóa toàn bộ từ định dạng, nội dung, ghi chú…

✓ Clear Formats: Chỉ xóa định dạng

✓ Clear contents: Chỉ xóa nội dung

✓ Clear comment: chỉ xóa ghi chú
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BÀI 02. CÁC ĐỐI TƯỢNG VÀ THAO TÁC CƠ BẢN (tiếp)

IV. ĐỊA CHỈ Ô (Tiếp theo)

❖ Trộn ô: Chọn các ô cần trộn→ thẻ Home → Nhóm Alignment → Công cụ Merge…

❖ Xuống dòng tự động trong 1 Ô: Chọn Ô →Wrap text.

❖ Xuống dòng thủ công trong 1 Ô: Click đúp chuột vào ô → Di chuyển dấu nháy tại nơi

cần xuống dòng →Alt + Enter

❖ Chỉnh sửa nội dung trong 1 Ô: Chọn Ô → F2 hoặc chọn Ô → Đưa dấu nháy vào

thanh công thức hoặc Click đúp chuột vào Ô

❖ Tạo ghi chú (Comment): Chuột phải vào ô chứa ghi chú→

❑ Insert Comment (hoặc Shift+F2). 

❑ Để sửa , chọn Edit Comment

❑ Xóa thì chọn Delete Comment

❑ Chèn hình vào Comment: Chuột phải vào viền ngoài → Format comment → Colors 

and lines → Color → Fill Effects → Picture
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BÀI 02. CÁC ĐỐI TƯỢNG VÀ THAO TÁC CƠ BẢN (tiếp)

V. TÊN VÙNG

• Vùng là tập hợp nhiều ô được chọn, được ký hiệu bởi địa chỉ đầu tiên và cuối cùng

trong vùng chọn, kết hợp dấu “:”, ví dụ A1:C10 là vùng từ ô A1 đến ô C10

• Khi sử dụng công thức chỉ cần gọi tên vùng mà không cần quét chọn vùng
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BÀI 02. CÁC ĐỐI TƯỢNG VÀ THAO TÁC CƠ BẢN (tiếp)

V. TÊN VÙNG

❖ Chọn vùng: Chọn trỏ chuột vào giữa 1 ô đầu tiên và quét chọn ra một vùng

❖ Chọn vùng nhanh: Chọn ô đầu tiên→ giữ SHIFT đồng thời chọn ô cuối cùng, hoặc

Ctrl+ Shift + End (chỉ áp dụng cho vùng có dữ liệu)

❖ Đặt tên vùng: Quét chọn vùng cần đặt tên → gõ tên vào ô NameBox→ Enter

(hoặc chuột phải vào vùng chọn và chọn Define Name)

❖ Quy tắc đặt tên: tb + tên Sheet + dấu chấm + tên Cột hoặc dòng hoặc vùng

o VD: tbNhatKy.MaCtu

❖ Gọi nhanh tên vùng: nhấn phím F3 để gọi các tên vùng đã đặt tên
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BÀI 02. CÁC ĐỐI TƯỢNG VÀ THAO TÁC CƠ BẢN (tiếp)

V. TÊN VÙNG

❖ Chỉnh sửa vùng:

❑ C1: Thẻ Formulas→ Name Manager→ Chọn tên vùng cần sửa→ Edit

❑ C2: Hoặc nhấn Ctrl +F3→ Edit
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BÀI 03. ĐỊNH DẠNG DỮ LIỆU CƠ BẢN TRONG EXCEL

I. CÁC KIỂU ĐỊNH DẠNG THƯỜNG DÙNG

Chọn Ô → thẻ Home→ Nhóm Number → Chọn kiểu định dạng trong khung chọn.
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BÀI 03. ĐỊNH DẠNG DỮ LIỆU CƠ BẢN TRONG EXCEL

II. ĐỊNH DẠNG DỮ LIỆU KIỂU SỐ

❖ Kiểu số: Number Format

Một số lưu ý về định dạng số:

❑ Số nên để căn chỉnh theo mặc định của Excel là bên phải

❑Số nên định dạng phần nghìn và thập phân bằng dấu ngăn cách tự động.

❑Trước khi gõ số thập phân, nên ktra dấu thập phân là dấu “,” hay “.”

❑Nếu số không nằm bên phải, thì phải kiểm tra lại bằng các cách sau:

▪ Chọn vào ô chứa số → Chọn vào dấu ngăn cách tự động

❑Nếu số ở dạng Text, dùng một số cách sau để chuyển sang dạng Number:

▪ Nhân số đó với 1 sang cột khác, sau đó copy và dán dạng giá trị ngược lại

▪ Dùng hàm VALUE
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BÀI 03. ĐỊNH DẠNG DỮ LIỆU CƠ BẢN TRONG EXCEL

II. ĐỊNH DẠNG DỮ LIỆU KIỂU NGÀY THÁNG

❖ Kiểu ngày tháng đầy đủ: Shordate

Một số lưu ý về định dạng Date:

❑ Ngày tháng về bản chất là một con số, vì vậy nó mang các đặc điểm của dạng 

Number, nhưng được định dạng kiểu khác Number.

❑ Định dạng ngày tháng phải gõ theo đúng định dạng của hệ thống

❑ Khi chọn ô và chọn định dạng kiểu General hoặc dấu ngăn cách thập phân tự động, 

nếu nó chuyển về dạng số là chuẩn định dạng Date, còn không là đang dạng Text.

❑ Để chuyển nhanh sang dạng Date, dùng phép nhân số đó với 1 sang 1 cột khác, sau 

đó copy và dán dạng giá trị ngược lại vào cột đó, rồi định dạng lại dạng Date

TRUNG TÂM TIN HỌC SAO VIỆT                      093 11 44 858                     blogdaytinhoc.com                Bạch Xuân Hiến

25



II. ĐỊNH DẠNG DỮ LIỆU KIỂU CHUỖI

❖ Định dạng kiểu chuỗi: Text

❑ Kiểu Text nên căn chỉnh về bên trái theo mặc định Excel

❑ Để chuyển định dạng số sang kiểu Text, sử dụng hàm TEXT

❑ Các số khi cắt từ một chuỗi, sẽ cho ra kiểu TEXT

❑ Để kiểm tra định dạng TEXT sử dụng hàm ISTEXT

Lưu ý:

✓ Sao chép định dạng nhanh: dùng công cụ Format Painter

✓ Căn chỉnh định dạng hệ thống: Windows+S→ Control Panel→ Clock and Region→

Change…Formats→ Additional Settings..→

(Numbers= định dạng số; Time= định dạng giờ phút giây; Date= định dạng ngày

tháng năm)

BÀI 03. ĐỊNH DẠNG DỮ LIỆU CƠ BẢN TRONG EXCEL
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1. Khi gõ số dạng thập phân, cần chú ý điều gì sau?

a. Cứ dấu thập phân là dấu phẩy (,)

b. Cần xác định dấu thập phân đang sử dụng là gì mới gõ

2. Để nhận biết dấu thập phân đang sử dụng, thực hiện cách nào sau?

a. Vào hệ thống của máy tính để kiểm tra

b. Gõ một con số (ví dụ gõ 10000) vào Excel, sau đó chọn dấu ngăn cách tự động để nhận biết

3. Khi gõ số 12,500,120.54 vào Excel, cần chú ý điều gì?

a. Cứ gõ và dùng dấu ngăn cách như số trên, với dấu phẩy (,) là dấu ngăn phần nghìn

b. Phải xác định dấu ngăn cách thập phân trước khi gõ

4. Khi nhập liệu số, dấu hiệu nhận biết nhập liệu đúng định dạng dữ liệu kiểu số là gì?

a. Số sau khi gõ tự nằm bên phải của Ô

b. Tự có dấu ngăn cách phần nghìn nếu gõ số có 3 chữ số và chọn dấu ngăn cách tự động

c. Số sau khi gõ nằm bên trái của Ô

d. Cả a và b đều đúng
27
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1. Khi gõ dữ liệu dạng ngày tháng năm, cần chú ý điều gì sau?

a. Cứ gõ ngày rồi đến tháng rồi đến năm

b. Cần xem định dạng hệ thống kiểu ngày trước tháng hay tháng trước ngày, sau đó mới gõ

2. Để nhận biết dữ liệu dạng ngày tháng năm gõ đã đúng chưa, chọn điều nào sau?

a. Sau khi gõ dữ liệu nằm bên phải

b. Sau khi gõ, khi chọn ô đó và chọn vào dấu ngăn cách tự động nó sẽ biến thành con số

3. Khi nhận được một tờ hóa đơn có ghi ngày là 31/12/2022, sẽ nhập liệu thế nào?

a. Kiểm tra hệ thống xem ngày trước hay tháng trước rồi mới gõ

b. Vào hệ thống máy tính để chỉnh sửa định dạng thời gian về dạng dd/mm/yyyy rồi mới gõ

c. Cả hai ý trên đều đúng

28
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BÀI 04. TẠO VÀ TRÌNH BÀY BẢNG TÍNH

I. TẠO BẢNG

❖ Tạo, định dạng khung viền và màu sắc

C1: Quét chọn vùng cần tạo → Chọn công cụ Border →All Border
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BÀI 04. TẠO VÀ TRÌNH BÀY BẢNG TÍNH
I. TẠO BẢNG

❖ Tạo, định dạng khung viền và màu sắc

C2: Quét chọn vùng cần tạo→ Chuột phải→ Format cells→ Border 
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BÀI 04. TẠO VÀ TRÌNH BÀY BẢNG TÍNH (tiếp)

II. SAO CHÉP ĐỊNH DẠNG NHANH VỚI FORMAT PAINTER

Để tạo nhanh các định dạng giống nhau (màu sắc, khung viền…), thì ta nên sử

dụng công cụ có sẵn Format painter

B1: Chọn vùng có định dạng cần sao chép → Thẻ Home → Bấm chọn vào công cụ 

Format Painter, xuất hiện con trỏ kèm cái chổi

B2: Bấm chọn ô đầu tiên của vùng cần dán
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BÀI 04. TẠO VÀ TRÌNH BÀY BẢNG TÍNH (tiếp)

III. CĂN CHỈNH NỘI DUNG TRONG BẢNG

Chọn ô cần căn chỉnh, sau đó chọn một trong các công cụ sau
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BÀI 04. TẠO VÀ TRÌNH BÀY BẢNG TÍNH (tiếp)

IV. CÁC BƯỚC NÊN THỰC HIỆN TRƯỚC KHI TẠO BẢNG TÍNH

1. Xác định hướng giấy và khổ giấy chuẩn A4 (hoặc A3, A5…)

o Vào thẻ Page layout và chọn theo các mục sau

Orientation: Hướng giấy Size: Khổ giấy

2. Chọn Font chữ “Time New Roman” cho toàn bộ bảng tính

3. Kẻ bảng, hoàn thiện tiêu đề, chỉnh độ rộng các cột phù hợp nội dung

4. Hoàn thiện các nội dung liên quan sau khi đã hoàn thiện các bước trên

5. Định dạng dữ liệu cho các cột trước khi nhập liệu
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V. THỰC HÀNH
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BÀI 04. TẠO VÀ TRÌNH BÀY BẢNG TÍNH (tiếp)
CÔNG TY TNHH GIÁO DỤC TIN HỌC SAO VIỆT

MST: 360.370.8616

ĐT: 0812.114.345      Website: blogdaytinhoc.com

Số lệnh

LỆNH ĐIỀU ĐỘNG NỘI BỘ

Căn cứ tình hình sản xuất, kinh doanh giữa các chi nhánh của Công Ty, nay BGĐ yêu cầu BP Kế

toán kho, BP Kho chuyển hàng từ chi nhánh……………………….. Tại địa chỉ………………….

…………………………………….. Đến chi nhánh ……………………………tại địa chỉ ……..

…………………………………………………………………..

Mã hàng Tên hàng SL xuất Ghi chú

Biên Hòa, ngày……..tháng…...…năm…………..

Thủ kho Kế toán kho Ban giám đốc
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BÀI 04. TẠO VÀ TRÌNH BÀY BẢNG TÍNH 

(tiếp)

CÔNG TY TNHH GIÁO DỤC TIN HỌC SAO VIỆT

MST: 360.370.8616

ĐT: 0812.114.345      Website: blogdaytinhoc.com

SỔ QUỸ TIỀN MẶT
Loại quỹ:……………..

Ngày 

Ghi sổ

Ngày 

Chúng từ
Số chứng từ Nội dung Thu Chi Tồn Ghi chú

Sổ này có…..trang, từ trang….. Đến trang………..

Ngày mở sổ:

Biên Hòa, ngày……..tháng…...…năm…………..

Thủ quỹ Kế toán trưởng Giám đốc

5. THỰC HÀNH
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BÀI 04. TẠO VÀ TRÌNH BÀY BẢNG TÍNH

(tiếp)
5. THỰC HÀNH
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BÀI 05. KỸ NĂNG IN ẤN

I. CÀI ĐẶT MÁY IN

Vào File→ Print hoặc nhấn tổ hợp phím Ctrl+P

1 Pritnt: Lệnh in

2 Số bản in

3 Chọn máy in

4 In từ trang số.. Đến số…

5 In kiểu 2 mặt hoặc 1 mặt

6 Hướng giấy

7 Khổ giấy

8 Tự động dồn cột hoặc dòng vào 1 trang in

9 Hiển thị khung lưới chỉnh trang in

10 Hiển thị và xem trang in

Xem them hình ảnh trong trang sau
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BÀI 05. KỸ NĂNG IN ẤN

I. CÀI ĐẶT MÁY IN
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BÀI 05. KỸ NĂNG IN ẤN

Lưu ý: Khi thực hanh các thao tác liên quan in ấn, học viên phải bật chế độ in (Ctrl + P) để 

kiểm tra lại các thao tác đã đúng chưa

II. TẠO VÙNG IN CỐ ĐỊNH

Khi in bảng tính, chỉ có duy nhất vùng được cố định in ra mà thôi

❖ Tạo vùng in: Chọn vùng → Page layout → Print Area → Set Print Area

❖ Thêm vùng in: Chọn vùng cần thêm (Vùng này không đè lên vùng đã cố định trước 

đó) → Page layout → Print Area →Add To Print Area

❖ Để xóa in: Chọn vùng → Page layout → Print Area → Clear Print Area

Xem thêm hình trang sau
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BÀI 05. KỸ NĂNG IN ẤN

II. CỐ ĐỊNH VÙNG IN

TRUNG TÂM TIN HỌC SAO VIỆT                      093 11 44 858                     blogdaytinhoc.com                Bạch Xuân Hiến

42



BÀI 05. KỸ NĂNG IN ẤN

II. DỒN TRANG IN TỰ ĐỘNG

Khi trang in có một số ít cột hoặc dòng vượt quá trang in hiện tại, để căn chỉnh nhanh cho 

vào trong trang ta sử dụng chức năng có sẵn trong Excel, tuy nhiên phải đảm bảo là bạn đã cố 

gắng tự căn chỉnh bằng tay.

❖ File → Print → tại mục “Scale to fit” nằm gần chữ Page Setup lựa chọn theo hình sau:

TRUNG TÂM TIN HỌC SAO VIỆT                      093 11 44 858                     blogdaytinhoc.com                Bạch Xuân Hiến

43



BÀI 05. KỸ NĂNG IN ẤN

IV. NHẮC LẠI TIÊU ĐỀ DÒNG, CỘT KHI IN

Khi bảng tính có nhiều trang, dòng tiêu đề nên được nhắc lại cho các trang sau.

❖ Các bước thực hiện:

Thẻ Page layout → Print Titles → thẻ Sheet → bấm chuột trái vào “Row to repeat at top”, sau 

đó di chuyển chuột ra ngoai bảng Excel, di chuyển con trỏ màu đen vào dòng muốn nhắc lại 

khi in

Xem thêm hình sau:
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BÀI 05. KỸ NĂNG IN ẤN

IV. NHẮC LẠI TIÊU ĐỀ DÒNG, CỘT KHI IN
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BÀI 05. KỸ NĂNG IN ẤN

IV. ĐÁNH SỐ TRANG

Một bảng tính có nhiều trang in, nên đánh số trang để dễ quản lý.

Các bước thực hiện:

Thẻ Page layout → Print Titles → thẻ Header/Footer → chọn một trong 2 lựa chọn sau:

1. Custom header: đánh số trang trên đầu trang

2. Custom Footer: đánh số trang dưới chân trang
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BÀI 05. KỸ NĂNG IN ẤN

IV. ĐÁNH SỐ TRANG

Một bảng tính có nhiều trang in, nên đánh số trang để dễ quản lý.

Các bước thực hiện
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I. LỌC CƠ BẢN

Để những đối tượng cần kiểm tra được hiển thị, ta dùng chức năng lọc dữ liệu, ví dụ để

kiểm tra những người có tên Trinh, nếu đi dò từng dòng sẽ rất lâu, nhưng nếu lọc ra riêng tất

cả những người tên Trinh thì kiểm tra rất dễ.

1. Các bước lọc dữ liệu:

❖ B1: Quét chọn tất cả vùng dữ liệu, bao gồm cả tiêu đề

❖ B2: Data → Filter

❖ B3: Để lọc một đối tượng, chọn vào nút lọc trên đầu cột, gõ từ gợi ý vào ô tìm kiếm

(Search) tại mục số 4 sau đó nhấn OK

Xem thêm hình ảnh trang sau

BÀI 06: LỌC VÀ SẮP XẾP DỮ LIỆU TRONG EXCEL
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I. LỌC CƠ BẢN

1. Các bước lọc dữ liệu

BÀI 06: LỌC VÀ SẮP XẾP DỮ LIỆU TRONG EXCEL
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I. LỌC CƠ BẢN

2. Một số dạng lọc cơ bản:

❖ Text Filter: Khi lọc cột dạng chuỗi

❑ Equals: Lọc chính xác một từ

❑ Does Not Equal: Lọc các từ khác biệt 1 từ quy ước

❑ Begins With: Lọc bắt đầu bằng 1 từ

❑ End With: Lọc kết thúc với 1 từ

❑ Contains: Lọc các đối tượng có chứa từ cần lọc

❑ Does Not Contain: Lọc từ cần lọc không chứa từ quy ước

BÀI 06: LỌC VÀ SẮP XẾP DỮ LIỆU TRONG EXCEL
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I. LỌC CƠ BẢN

2. Một số dạng lọc cơ bản:

❖ Number Filter: khi lọc cột số

❑ Equals: = số quy ước

❑ Does Not Equal: <> số quy ước

❑ Greater Than: > số quy ước

❑ Greater Than Or Equal: >=số quy ước

❑ Less Than: < số quy ước

❑ Less Than Or Equal To : <= số quy ước

❑ BetWeen: Lọc trong một khoảng quy ước

❑ Top 10: n số lớn nhất, hoặc nhỏ nhất

❑ Above Average: Các số lớn hơn giá trị trung bình cộng

❑ Below Average: Các số nhỏ hơn giá trị trung bình cộng

BÀI 06: LỌC VÀ SẮP XẾP DỮ LIỆU TRONG EXCEL
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II. SẮP XẾP CƠ BẢN

1. SẮP XẾP MỘT CỘT

❖ B1: Thao tác theo B1 và B2 của lọc dữ liệu

❖ B2: Bấm vào biểu tượng lọc, chọn Sort A→Z hoặc Sort Z→A

2. SẮP XẾP NHIỀU CỘT

❖ B1: Thao tác theo B1 và B2 của lọc dữ liệu

❖ B2: Data→ Công cụ Sort (Gần công cụ Filter)

▪ Add Level: Thêm cột cần sắp xếp

▪ Tại bảng hiện ra ở mục số 4, kích chọn cột cần sắp xếp sau đó nhấn OK

BÀI 06: LỌC VÀ SẮP XẾP DỮ LIỆU TRONG EXCEL
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BÀI 06: LỌC VÀ SẮP XẾP DỮ LIỆU TRONG EXCEL
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I. TÌM KIẾM TRONG EXCEL

Để tìm kiếm một từ, một con số…, ta dùng chức năng Find sẵn có trong Excel.

Các bước thực hiện:

❖ B1: Nhấn Ctrl+ F

❖ B2: Gõ từ cần kiếm trong ô Find what

❖ B3: Chọn Find Next

❑Match case: Tìm từ hoa thường

❑Match entire cell contents: 

Tìm từ chính xác với từ trong ô tìm kiếm

BÀI 07: TÌM KIẾM VÀ THAY THẾ TRONG EXCEL
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II. THAY THẾ TRONG EXCEL

Để thay thế một từ, một con số… bằng một từ hoặc một con số khác, ta dùng chức

năng Replace sẵn có trong Excel.

Các bước thực hiện:

❖ B1: Nhấn Ctrl+ F

❖ B2: Chọn thẻ Replace

❖ B3: Chọn các phép thay thế sau:
❑ Replace: Thay thế từng từ

❑ Replace all: Thay thế toàn bộ các từ Tìm thấy

BÀI 07: TÌM KIẾM VÀ THAY THẾ TRONG EXCEL
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I. CÁC PHÉP TÍNH CƠ BẢN

Cộng (+), Trừ (-), Nhân (*), Chia (/)

II. QUY TẮC THỰC HIỆN PHÉP TÍNH TRONG EXCEL

= Nội dung phép tính→ Enter, ví dụ: =3+2 → Enter sẽ ra kết quả là 5

III. THỰC HIỆN PHÉP TÍNH VỚI ĐỊA CHỈ Ô

Để thực hiện tính toán trong Excel, thực hiện chủ yếu trên địa chỉ ô, ví dụ: =A1+A5+B13

IV. SAO CHÉP CÔNG THỨC TRONG EXCEL

Có nhiều cách sao chép công thức sang một ô khác:

▪ C1: Chọn ô có công thức → Ctrl + C, sau đó chọn nơi cần dán→ Ctrl + V

▪ C2: Chọn ô có công thức, di chuyển chuột vào góc dưới bên phải của ô đang chọn, 

xuất hiện dấu cộng màu đen  → giữ chuột trái và kéo

▪ C3: Quét chọn từ ô đầu tiên có công thức đến hết vùng cần sao chép, nhấn Ctrl+D (sao

chép từ trên xuống) hoặc Ctrl+ R (sao chép từ trái qua phải)

BÀI 08: TÍNH TOÁN VÀ CÔNG THỨC TRONG EXCEL
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V. CÔNG THỨC TRONG EXCEL

Công thức là một tập hợp các phép tính, biểu thức toán học, hàng số, các biến số… Các

phép tính cơ bản gồm: + (Cộng), - (Trừ), * (Nhân), / (Chia)

Ví dụ: tại ô A3, nhập công thức =A1+A2-A5+25+SUM(A8:C9) → Enter

Biến=Địa chỉ ô Hàng số Hàm

BÀI 08: TÍNH TOÁN VÀ CÔNG THỨC TRONG EXCEL
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BÀI 08. CÁC ĐỐI TƯỢNG VÀ THAO TÁC CƠ BẢN (tiếp)

VI. ĐỊA CHỈ TƯƠNG ĐỐI VÀ TUYỆT ĐỐI TRONG EXCEL

❖ Địa chỉ tương đối: là địa chỉ bị thay đổi khi sao chép công thức từ địa chỉ ô này sang 

địa chỉ ô khác

❖ Địa chỉ tuyệt đối: là địa chỉ không bị thay đổi khi sao chép công thức sang địa chỉ ô 

khác

❑ Để cố định địa chỉ, dùng dấu $, $ trước chữ cái là cố định cột, trước số là cố định

dòng. 

❑ ví dụ $A$1 là cố định cả dòng và cột, $A1 là cố định cột không cố định dòng, A$1 

là cố định dòng không cố định cột

❑ Phím tắt nhanh để cố định địa chỉ trong công thức là dùng: F4.
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I. MỘT SỐ CHÚ Ý TRƯỚC KHI THỰC HIỆN HÀM:

1. Phải nắm rõ yêu cầu thực tế của công việc đang làm

o Bước này cần phải biết làm 1 ví dụ nhỏ bằng thủ công

o Xác định trình tự từng bước của việc làm bằng tay

2. Xác định hàm sẽ sử dụng để phục vụ cho công việc ở bước 1 

o Bước này, phải mô tả được yêu cầu bài toán theo một cách tổng quát và phổ thông nhất

o Mở Google và tra cứu với cụm từ “Hàm dùng để” + “Yêu cầu”

Ví dụ: “Hàm dùng để tìm kiếm thông tin trong Excel là hàm gì?”

3. Cách sử dụng hàm

❖ Phải nắm được ý nghĩa của hàm (hàm này dùng để làm gì?)

❖ Phải nắm được cấu trúc của hàm 
o Tên hàm phải đúng theo danh sách gợi ý

o Hàm có bao nhiêu tham số

o Nhiệm vụ từng tham số là gì

o Dấu ngăn cách tham số phải theo hướng dẫn của hàm

BÀI 09: KIẾN THỨC CƠ BẢN VỀ HÀM TRONG EXCEL
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I. MỘT SỐ CHÚ Ý TRƯỚC KHI THỰC HIỆN HÀM:
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1. Trước khi được giao một công việc tính toán, cần phải làm gì trước?

a. Xác định hàm gì sẽ sử dụng để tính toán

b. Cần nắm rõ yêu cầu thực tế công việc là gì

2. Sau khi xác định được yêu cầu cụ thể của công việc, nên làm gì trước?

a. Đi tra tìm hàm sử dụng cho công việc đang cần tính toán

b. Tư duy bằng phương pháp thủ công và trình tự tính toán trước

3. Cấu trúc hàm gồm những thành phần nào?

a. Tên hàm và tham số

b. Dấu ngăn cách các tham số

c. Cả 2 ý trên

4. Trước khi sử dụng hàm, cần chú ý điều gì sau?

a. Hàm đang sử dụng có nhiệm vụ là gì

b. Hàm đang sử dụng có bao nhiêu tham số

c. Ý nghĩa từng tham số là gì

d. Dấu ngăn cách tham số là dấu gì

e. Cả 4 ý trên

61
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5. Có các hàm như sau, trong mỗi hàm, hãy cho biết?

a. Các hàm dưới đây có bao nhiêu tham số và dấu ngăn cách tham số là dấu gì?

62
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LƯU Ý QUAN TRỌNG

CHƯA ĐỌC HOẶC CHƯA HIỂU BÀI 9 VÀ BÀI 

10, TUYỆT ĐỐI KHÔNG ĐƯỢC QUA

KIỂM TRA TRẮC NGHIỆM KỸ CÀNG

63
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I. HÀM TÍNH TỔNG SUM

Cú pháp: =SUM(quét chọn vùng cần tính)

Lưu ý: Để tính tổng nhanh, có thể áp dụng 1 số thủ thuật sau:
Đặt con trỏ chuột vào ô cần tính tổng hoặc quét chọn vùng bao gồm cả dòng cần tính tổng hoặc cột 

cần tính tổng hoặc cả dòng và cột cần tính tổng → Nhấn vào biểu tượng AutoSum hoặc nhấn Alt =

Tuy nhiên đảm bảo không có ô trống hoặc dòng trống nào trong vùng tính tổng

II. HÀM ĐẾM COUNT, COUNTA, COUNTBLANK

Cú pháp: 

=COUNT(Vùng cần đếm) → Đếm số ô có chứa ký tự dạng số

=COUNTA(Vùng cần đếm) → Đếm số ô không rỗng

=COUNTBLANK(Vùng cần đếm) → Đếm các ô rỗng

Chú ý: Nếu đếm các kiểu ký tự dạng chữ cái hay ký tự đặc biệt, phải để trong dấu ngặc kép, 

ví dụ: COUNT(a,b,c,1) hàm này sẽ báo lỗi, chúng ta phải =COUNT(“b”,”c”,1)
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I. SỬ DỤNG HÀM TÌM GIÁ TRỊ LỚN NHẤT, NHỎ NHẤT

❖ Hàm MIN, tìm ra giá trị nhỏ nhất trong dãy số, cú pháp: 

=MIN(quét chọn vùng)

❖ Hàm MAX, tìm ra giá trị lớn nhất trong dãy số, cú pháp: 

=MAX(quét chọn vùng)

II. SỬ DỤNG HÀM TÍNH GIÁ TRỊ TRUNG BÌNH CỘNG

❖ Hàm AVERAGE, tính trung bình cộng

=AVERAGE(Quét chọn vùng cần tính)

BÀI 12: HÀM TÌM GIÁ TRỊ LỚN NHẤT, NHỎ NHẤT VÀ 

TÍNH TRUNG BÌNH CỘNG
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HÀM TÍNH TỔNG PHỤ SUBTOTAL

Hàm này thường áp dụng khi bảng tính có các nhóm, nó có 2 điểm đặc biệt:

✓ Số liệu tổng tự động cập nhật khi thêm nhóm mới

✓ Tự động trừ đi các dòng bị ẩn

✓ Tổng phụ không thống kê các tổng con

❖ Cú pháp: 

= SUBTOTAL(Chỉ số hàm, Quét chọn vùng cần thống kê)

❖ Các chỉ số hàm tương ứng

▪ Từ 1→11 là thống kê cả giá trị bị ẩn

▪ 101→ 111 là chỉ thống kê giá trị được hiển thị

BÀI 13: HÀM TÍNH TỔNG PHỤ
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❖ Hàm DAY, MONTH, YEAR trả về ngày, tháng, năm tương ứng của chuỗi ngày tháng

= DAY(Chuỗi dạng Date), các hàm còn lại tương tự

❖ Hàm HOUR, MINUTE, SECOND lấy ra giờ hoặc phút hoặc giây trong chuỗi

= HOUR (Chuỗi chứa số dạng Date có chứa giờ), các hàm còn lại tương tự

❖ Hàm DATE, TIME là hàm nối các thời gian riêng lẻ về một chuỗi

= DATE (năm, tháng, ngày) 

=TIME (giờ, phút, giây)

❖ Hàm DATEVALUE là hàm chuyển chuỗi Date dạng Text về dạng Date đúng.

= DATEVALUE(Chuỗi Date dạng Text)

❖ Hàm WEEKDAY trả về ngày thứ mấy trong tuần

=WEEKDAY(chuỗi số dạng Date, k) thường là k=1, tướng ứng Chủ nhật là số 1

BÀI 14: HÀM XỬ LÝ THỜI GIAN
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❖ Hàm LEFT, RIGHT

Lấy ra các ký tự bên trái hoặc bên phải của một chuỗi ký tự, Cú pháp:

=LEFT(Chuỗi có ký tự muốn cắt, số ký tự cần cắt)

=RIGHT(Chuỗi có ký tự muốn cắt, số ký tự cần cắt)

❖ Hàm MID

Cắt ra các ký tự bất kỳ của một chuỗi ký tự, Cú pháp: 

=MID(Chuỗi có ký tự muốn cắt, vị trí cắt đếm từ trái qua, số ký tự cần cắt)

❖ Hàm LEN

Đếm số ký tự trong một chuỗi, cú pháp:

=LEN(Chuỗi có ký tự muốn đếm)

❖ Hàm TRIM

Xóa các ký tự trắng vô nghĩa trong chuỗi, ví dụ SAO   VIỆT→ SAO VIỆT

=TRIM(Chuỗi chứa ký tự cần xử lý)

BÀI 15: HÀM XỬ LÝ CHUỖI
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❖ Hàm CHAR(10) dạng ký tự xuống dòng

Nối các từ với nhau, khi chọn Wraptext, vị trí bắt đầu của từ phía sau sẽ ngắt sang dòng

khác trong ô

=A&CHAR(10)&B… với A và B là các từ hoặc các chuỗi ký tự bất kỳ

❖ Hàm CONCATENATE

Nối các chuỗi với nhau, tương tự như phép nối &

=CONCATENATE(chuỗi 1, chuỗi 2….)

❖ Phép nối chuỗi &

Nối các từ với nhau

=A&B →AB… với A và B là các từ hoặc các chuỗi ký tự bất kỳ
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❖ Hàm INT lấy phần nguyên từ số thập phân

=INT(Số thập phân)

❖ Hàm ROUND làm tròn số, phần thập phân từ 1- 4 sẽ được tính là 0, phần thâp phân từ 5-

9 sẽ được quy tròn là 1 đơn vị và cộng vào kết quả

=ROUND(Số thập phân, phần thập phân cần lấy bao nhiêu số)

❖ Hàm ROUNDDOWN làm tròn số dạng không tăng hoặc giảm vào phần đc làm tròn, 

nghĩa là nó chỉ bỏ đi phần phía sau.

= ROUNDDOWN(Số thập phân, phần thập phân cần lấy bao nhiêu số)

❖ Hàm MOD lấy số dư

=MOD(Số bị chia, số chia)

❖ Hàm VALUE chuyển ký tự số dạng Text sang Number

=VALUE(ký tự số dạng Text)

BÀI 16: HÀM XỬ LÝ SỐ
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I. HÀM KIỂM TRA THÔNG TIN

❖ Hàm ISERROR, kiểm tra lỗi

❖ Hàm ISTEXT, kiểm tra có phải dạng Text

❖ Hàm ISNUMBER, kiểm tra ký tự có phải Number

II. HÀM XỬ LÝ LỖI

❖ Hàm IFERROR, dùng để thay thế giá trị bị lỗi bằng 1 giá trị nào đó, cú pháp:

IFERROR(Ô cần kiểm tra, giá trị muốn trả về nếu lỗi)

BÀI 17: HÀM KIỂM TRA THÔNG TIN VÀ XỬ LÝ LỖI
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❖ Hàm VLOOKUP, HLOOKUP

Tìm kiếm thông tin liên quan đến 1 đối tượng trong vùng tham chiếu, cú pháp:

= VLOOKUP(Đối tượng đi dò tìm, Vùng dò tìm, Cột số mấy có thông tin cần lấy, 0)

= HLOOKUP(Đối tượng đi dò tìm, Vùng dò tìm, Dòng số mấy có thông tin cần lấy,0)

Lưu ý: 

1. Tham số cuối cùng nếu là 0 là tìm kiếm tuyệt đối, tức là thông tin dò tìm có mặt tại 

hai bảng phải giống nhau về định dạng và giá trị, còn nếu 1 là tìm kiếm tương đối. 

Chương trình Excel nâng cao sẽ nghiên cứu sâu hơn về hàm tham số 1

2. Giá trị dò tìm trong hàm VLOOKUP luôn bắt đầu từ dò tìm tại cột đầu tiên trong 

bảng dò tìm.

3. Vùng tìm kiếm luôn phải cố định

BÀI 18: HÀM TÌM KIẾM (DÒ TÌM)
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I. PHÉP KIỂM TRA ĐIỀU KIỆN

❖ Bài toán có điều kiện thì ta phải kiểm tra

❖ Để kiểm tra 1 ĐK ta chỉ cần so sánh đối tượng cần kiểm tra với điều kiện đặt ra.

✓ Ví dụ để kiểm tra mặt hàng chuối thuộc nhóm X phải không, ta làm như sau: 

=B4=“X” → Enter

Lưu ý: Để ktra ĐK, sử dụng 6 phép so sánh sau: =, >, <, >=, <=,<>

BÀI 19: PHÉP KIỂM TRA VÀ HÀM CÓ ĐIỀU KIỆN
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II. HÀM CÓ ĐIỀU KIỆN IF

Khi kết quả trả về phụ thuộc vào kết quả của phép kiểm tra điều kiện ta dùng hàm IF.

=IF(Kiểm tra điều kiện, Kết quả muốn trả về nếu phép ktra đúng, Kết quả muốn trả về 

nếu phép ktra sai)

=IF (logical_test, [value_if_true], [value_if_false]) :

▪ logical_test: Kiểm tra điều kiện (Biểu thức so sánh)

▪ [value_if_true]: Kết quả muốn trả về khi kiểm tra điều kiện đúng(True)

▪ [value_if_false]: Kết quả muốn trả về khi kiểm tra điều kiện sai (False)

Một số ví dụ thực tế về hàm IF

Nếu điểm thi là 10 Thì
Con được Thưởng 1 chiếc
xe đạp điện

Ngược lại
Con phải tính 1 năm có bao nhiêu

giờ

Nếu điểm thi trên 5 Thì Bạn sẽ đậu tốt nghiệp Ngược lại
Bạn phải tìm kiếm có trong danh

sách ưu tiên không
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1. Để đếm số ô chứa dữ liệu dạng số dùng hàm gì sau?

a. COUNTA b. SUM c. MID d. COUNT

2. Để lấy ra ký tự bất kỳ trong chuỗi dung hàm gì sau?

a. VLOOKUP b. HLOOKUP c. RIGHT d. MID

3. Để tìm kiếm thông tin cho một đối tượng cho trước ở một bảng, mà đối tượng này 

có mặt ở một bảng chứa thông tin khác, có thể dùng hàm gì sau đây?

a. MID b. SUBTOTAL c. VLOOKUP d. HLOOKUP

4. Để lấy ra ký tự bên trái của một chuỗi ký tự, có thể dùng hàm gì sau đây?

a. MID b. RIGHT c. LEFT d. VLOOKUP

5. Khi bài toán có kết quả trả về phụ thuộc điều kiện cho trước, dung hàm nào sau?

a. WEEKDAY b. LEFT c. IF d. SUM

6. Để trả về kết quả là giá trị lớn nhất trong một vùng dữ liệu, sử dụng hàm gì?

a. MID b. MIN c. COUNT d. MAX
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BÀI 20: BÀI THI TỔNG KẾT CUỐI KHÓA
(12 Câu Lý Thuyết Làm Vào Vở, Thực Hành Làm Theo File Excel Trên Website)



7. Để trả về kết quả là giá trị nhỏ nhất trong vùng dữ liệu, sử dụng hàm gì?

a. MAX b. DAY c. MIN d. COUNTA

8. Để trả về kết quả là một ngày trong tháng, sử dụng hàm gì?

a. MONTH b. WEEKDAY c. DAY d. SECOND

9. Để làm tròn một số, dùng hàm gì?

a. MONTH b. VALUE c. ROUND d. INT

10. Để lấy ra phần nguyên từ một số thập phân, sử dụng hàm gì sau?

a. MID b. RIGHT c. LEFT d. VLOOKUP

11. Để tính trung bình cộng của một vùng dữ liệu, có thể sử dụng hàm gì?

a. SUBTOTAL b. LEFT c. AVERAGE d. SUM

12. Để trả về kết quả là giá trị lớn nhất trong một vùng dữ liệu, có thể sử dụng hàm gì?

a. MID b. SUBTOTAL c. COUNT d. MAX
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